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Welcome to IUEditor Manual.

You can download IUEditor from website below.

• IUEditor Homepage : http://iueditor.org

• IUEditor Facebook Page (Korean): https://www.facebook.com/iueditor

Introduction 1

http://iueditor.org
https://www.facebook.com/iueditor
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2 Introduction



CHAPTER 1

What is IUEditor?

IUEditor is optimized to simplify the complex process of design and development.

1.1 Advantages

• IUEditor is a GUI-based program which allows users to design a prototype without any coding.

• IUEditor allows users to develop a product or a website that supports multi-screen devices with just one IU
project file.

• IUEditor is integrated via backend layers such as python.

1.2 Values

• IUEditor enables designers to work together with developers without publishers so that your team or company
can save cost and time.

• IUEditor enables your team or company to ship products early, so you can adopt a lean process and iterate to
build a better product or website.

1.3 More . . .

• You can check javascript manual on http://cdn.iueditor.org/js/readme.html

3
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4 Chapter 1. What is IUEditor?



CHAPTER 2

Environment

IUEditor operates only on Mac OS X - Mojave. (10.14 +)

Browser support : Chrome, Safari, Firefox, Opera - current / IE 9+

5
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6 Chapter 2. Environment



CHAPTER 3

Menu

Description about IUEditor Menu Bar

3.1 IUEditor

• About IUEditor : Show IUEditor’s version info.

• Preference : Open IUEditor Preference window.

7
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3.2 File

• New Project : Open New Project window.

• Open : Open Finder to find IU Project file to open.

• Open Recent : Open recent IU Project file.

• Save : Save the current project.

• Save As : Save the current project under a different name.

• Close : Close current project.

3.3 Project

• Build : Generate HTML & CSS & JS files based on IU Project.

• Build Clean : Clean build data. It can fix program error.

• Stop : Stop the build.

• Project Setting : Open Project Setting panel.

• Project Code : Open Project Code panel.

8 Chapter 3. Menu
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• Refresh Page : Refresh current page. It can fix program error.

3.4 View

• Show Tab Bar : Show the tab bar.

• Show All Tabs : Show the entire tab.

• ZoomOut : Zoom Out stage.

• ZoomIn : Zoom In stage.

• Outline : Show or hide outline of widgets in canvas.

• Ruler : Show or hide ruler on canvas.

• Guide : Show or hide guide on canvas.

• Tracing : Show or hide tracing image on canvas.

• Enter Full Screen : Switch to full screen.

3.4. View 9
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3.5 Window

• Event : Open Event panel.

• Resource : Open Resource panel.

• Memo : Open Memo panel.

• Manage Custom Widgets : Open Manage Custom Widgets Panel.

• Log : Open log panel.

3.6 Help

• Search : Search IUEditor function.

• Documentation : Open IUEditor Manual page in the browser.

• Ask IUEditor : Go to the webpage to ask questions about the program.

• Acknowledgements : Show information about the APIs used in the program.

10 Chapter 3. Menu



CHAPTER 4

Top Toolbar

Top Toolbar contains Command / Tab Menu / Stage area.

11
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4.1 Command

Command Area consists of project-level features.

• Build Button : Generate HTML & CSS & JS files based on IU Project.

• Server Stop Button : Stop the local host server.

• Select Build-Type Button : Select Build-Type to Build. (HTML or Django)

• Design / Develop / Prototype : Select Design Mode, Develop Mode or Prototype Mode .

4.2 Tab Menu

Tab Menu area consists of 6 tabs - Style/ Property/ Text/ Transform/ Mouse-Over/ and Link.

• Style Tab : In Style Tab, you can modify Radius / Border / Background-Image / Box-Shadow / Opacity.

• Property Tab : In Property Tab, you can set & change properties of each widget. Each widget has individual
property options.

• Text Tab : In Text Tab, you can modify Font-family / Font-size / Font-weight (thickness) / Font-color /
Line-height / Heading / Font-alignment.

• Transform Tab : In Transform Tab, you can modify Rotation property.

• Mouse-Over Tab : In Mouse-Over Tab, you can add Mouse-Over actions to each widget. (e.g. BG-color,
Text-color, X-position, Y-position, width, height, BG-image position, . . . )

12 Chapter 4. Top Toolbar
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• Link Tab : In Link Tab, you can add Hyperlink to a certain widget.

4.3 Stage

• Tracing : Add virtual background image into your canvas, so that you can create design quickly.

• Page Setting : Modify current page’s Page Width and Media Query.

• Zoom : Apply Zoom-In / Zoom-Out to IUEditor’s canvas.

4.3. Stage 13
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14 Chapter 4. Top Toolbar



CHAPTER 5

Middle Toolbar

Middle Toolbar is placed at the top of canvas and contains Refresh / Position / Frame / Background Color / Show/Hide
Widget Button area.

15
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5.1 Refresh

Refresh current canvas.

5.2 Position

Position area consists of Position/ Align options/ Input fields/ Stepper for X & Y position.

• Position : Select position from select - Absolute/ Relative/ Fixed.

• Sub Position : Select sub position from select.

• Align Button : Consist of align vertical center and align horizontal center buttons and align multiple
element button.

• Position Setting Popup (Down Arrow) : You can change fixed center position, overflow, z-index
properties.

• X position input field & stepper : You can change X value by typing value into text field or
clicking stepper. (px or %)

• Y position input field & stepper : You can change Y value by typing value into text field or
clicking stepper. (px or %)

5.3 Frame

Frame area consists of Input fields/ stepper for width & height value.

• Width input field & stepper : You can change Width value by typing value into text field or click-
ing stepper. (px or %)

• Height input field & stepper : You can change Height value by typing value into text field or
clicking stepper. (px or %)

• Frame Setting Popup (Down Arrow) : You can change min-width , max-width , min-height , max-
height , calc-width , calc-height properties.

5.4 Background Color

Background Color area consists of set background color button/ set gradient popup. You can change the back-
ground color and the color gradient of the selected widget.

5.5 Show/Hide Widget Button

Show and Hide widget list.

16 Chapter 5. Middle Toolbar



CHAPTER 6

Widget Panel

Widget toolbar is at the right side of canvas. Open and close Widget Panel with Show/Hide Widget Button in the
middle tool bar. Widget panel consists of IU Widget / Custom Widget tab.

6.1 IU Widget

17
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In IU WIDGET tab, all available widgets in IUEditor will be shown. Fundamental elements including Box / Text
/ Image / Static Image / Cell widgets and other various widgets used in a web page are offered. All the provided
widgets are divided into Base, Complex, Programming groups. You can see the detailed information of each widget
by right-clicking the widget.

Go To Widget Property.

6.2 Custom Widget

In CUSTOM WIDGETS tab, custom widgets imported by Import Button (Window> Manage Custom Widgets) will
be shown. The widgets can be divided into customized widget groups. You can add custom widgets on canvas by
drag and drop or double clicking the widget. You can check the detailed information of a widget by right-clicking
it. All the information of custom widgets can be edited at Manage Custom Widget window.

• Refresh Button : Update custom widget library.

• Search Field : Search custom widget library by name or tag.

• Zoom in/Zoom out Button : Zoom in or out custom widget library.

Go To Manage Custom Widgets Panel .
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CHAPTER 7

Navigation

Navigation area is at the left side of canvas. Three key elements are Structure , Page ,and Composition.

7.1 Structure

The components of the current page (section, header, footer, page content, widget, . . . ) can be seen in this area.
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You can rearrange, remove, rename, and hide widgets from the structure.

• Add New Popup : Add a popup widget into the current page.

• Add New Panel : Add a panel widget into the current page.

• Add New Section : Add a section to the page content.

• Delete : Delete the selected element.

7.2 Page

Page tab shows the list of pages/groups included in the current project. You can add, remove, and rename
pages/groups.

• Add New Custom Page Button : Add a new custom page.

• Add New Page Button : Add a new page.

• Add New Group Button : Add a new group.

• Delete Button : Delete the selected page or group.

7.3 Composition

Composition tab shows the design compositions of the current project. You can add, remove, and rename composi-
tion & group.

• Add New Custom Composition Button : Add a new custom composition.

• Add New Composition Button : Add a new composition.

• Add New Group Button : Add a new group.

• Delete Button : Delete the selected composition or group.

7.4 References

How to rename widget, page, and group

1. Select the item (widget, page, or group) you want to rename

2. Press Enter or Tab key

3. Type new name as you want

4. Press Enter Key

Note: You can not use these names : id / ifdef / default
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CHAPTER 8

Canvas

Canvas is the preview of the website. The structure designed on the canvas by adding widgets will be shown in the
web page.

How to add widgets to canvas
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8.1 Context Menu - Single Widget

After selecting a single widget in canvas, right-click to open the Context Menu. Below are information and functions
in the Context Menu.

• Widgets : Shows the whole widgets placed at the current position of the mouse pointer.

• Add Memo : Open Memo Panel where you can add memo about the selected widget.

• Export to Widget : Open Export Widget Panel that is used to export Custom Widget .

• Show Event : Open Event Panel that allows us to add an event to the selected widget and later make adjust-
ments on events

• Select Tab : Switch Property panel on the top to the selected Tab.
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8.2 Context Menu - Multiple Widgets

After selecting multiple widgets in canvas, right-click to open the Context Menu.

• Align : Align the selected widgets according to the option chosen : Align Left / Align Center / Align Right
/ Align Top / Align Middle / Align Bottom

• Size : Fix the size of the selected widgets according to the option chosen : Match Width / Match Height

8.2. Context Menu - Multiple Widgets 23
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CHAPTER 9

Developer Mode

From the toolbar at the top, you can switch to Developer Mode by clicking Mode Switching Button.

In Developer mode, Code Panel will be shown. It consists of HTML ID / Custom Code .
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9.1 HTML ID

You can check and change HTML ID here. There is a check box for Export HTML ID. At the Project panel
(IUEditor Menu Bar > Preference), you can set the options from Export HTML ID Option. (Offered options: Always
include/ Optimization & customization)

9.2 Custom Code

You can write back-end, custom css, script code. The tab composition differs between widget and project type.
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CHAPTER 10

Prototype Mode

From the toolbar at the top, you can switch to Prototype Mode by clicking Mode Switch Button.

Prototype Mode offers Revision History / Project Workflow / Node Description page. You can refresh scenario by
clicking Reset Workflow and can build HTML Scenario by clicking Build Scenario. And Refresh
Thumbnail updates the page thumbnails that are included in the workflow and the page list.
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10.1 Revision History

Display the history of revision made in the current project. You can add or change the history.

• Add New Date : Create a new editable row field in the table.

• Remove Date : Delete the selected row from table.

10.2 Project Workflow

Display Workflow of the current project. Users can add nodes by drag and drop of page’s thumbnail. Press delete key
to delete the selected node.

• Default thumbnails : A list of page thumbnails included in the project.

• Custom thumbnails : A list of page thumbnails captured by using Page Capture Button on the toolbar in
editor mode.

Note: Thumbnails can be added by using Page Capture Button in Editor Mode.
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• Rectangle Button : Add a square dialog below the selected node.

• Rhombus Button : Add a diamond dialog below the selected node.

• Inward Label : Add a label on top of the selected node.

• Outward Label : Add a label below the selected node.

10.3 Node Description

Display the Node Description of the selected page. By adding memos to the node, you can send orders to partners
of your collaborative project. You can also add or change content in the Screen Description or Exception area.
Double-clicking the thumbnails on canvas also displays the node description.

• Memo image area : Select an image from the resource panel to replace the numbering in the screenshot
area.

• Add Memo Button : Create a new editable row field in the table.

• Delete Button : Delete the selected memo in the table.

When you click the screenshot area, the number of the selected memo will appear.
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CHAPTER 11

Project Setting

When you run Project > Project Setting (P) menu, Project Setting will be shown. You can modify settings from
Default, Meta, Build, Django Tab menu.

11.1 Default

31



Sphinx RTD theme demo Documentation, Release 2.1.2

• Project Title : Add the title of the project.

• Favicon : Add favicon image (Favicon image resource is required).

• Custom Header Code : Add custom code which will be applied to each page of the current project.

Note: After creation of a new project, Project Default Width cannot be changed.

11.2 Meta

• Meta Image : Add Meta Image for meta-data. (URL)

• Author : Add Author name for meta-data.

• Project URL : Add Project URL for meta-data.

• Project Keywords : Add Project Keywords for meta-data. (Multiple keywords are available)

• Project Description : Add Project Description for meta-data.

• Facebook Admin : Add Facebook Admin ID for meta-data.

• Facebook App ID : Add Facebook App ID for meta-data.
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11.3 Build

• Build Path : Set Build path for built files.

• Build Resource Path : Set Build Resource Path for built resource files.

• Resource Prefix : Set Resource Prefix.

• Link Prefix : Set Link Prefix.

• HTML Port : Set HTML Port for build.

Note: If your project’s domain isn’t the same as the root path, you have to modify Resource & Link Prefix.
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11.4 Django

Note: Django tab is available on Django Project.

• Django Build Path : Set Django Build path for Django build files.

• Django Resource Path : Set Django Resource Path for Django resource files.

• Django Resource Prefix : Set Django Resource Prefix.

• Run server after build : Set Run Server option.

• Django Port : Set Django Port for Django build.

• Python Interpreter Path : Set Python Interpreter Path for Django build.

• Django Manage.py Path : Set Manage.py path for Django build.
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CHAPTER 12

Project Code

When you click the Project > Project Code C button, Project Code panel will be shown.

You can add your code to all pages.

12.1 HTML

1 <head>
2 <!-- start : your code -->
3 <!-- auto generated code by IUEditor -->
4 <!-- end : your code -->
5 </head>
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12.2 Back-end

1 <!-- page head custom code for back-end : your code -->
2 <!DOCTYPE html>
3 <head>
4 <!-- start : your code -->
5 <!-- auto generated code by IUEditor -->
6 <!-- end : your code -->
7 </head>
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CHAPTER 13

Resource Panel

When you run Window > Resource (R) menu, Resource Panel will be shown. You can import resources (images,
videos, js, css, json) into Resource Panel.

Note: Supported Image File Types : gif, jpg, jpeg, png, ico, icns, svg, bmp

Note: Supported Video File Types : mp4, ogg, webm
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• Import Resource Button : Import resources from the local disk.

• Resource Type Select Button : Sort out files in Resource Panel by file type.

• Add New Folder Button : Add a new folder.

• Delete Button : Delete the selected file(s) or folder(s).

13.1 Resource Management Tips

• You can create groups and reorder files in resources.

• You can insert an image to widget by drag & drop into Image Widget.
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CHAPTER 14

Event Panel

When you run Window > Event (E) menu, Event Panel will be shown. You can add events like Scroll Animator or
Variable .
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14.1 Scroll Animator

Add Scroll Animator to animate widget by scrolling. When the target widget appear in the middle of browser, the
selected value will transform from before to after.

• X-Position : Add Scroll Animator to X-Position.

• Y-Position : Add Scroll Animator to Y-Position.
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• Opacity : Add Scroll Animator to Opacity.

14.2 Variable

Add Variable to the selected widget.
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• Variable Name : Show Variable list in your project.

• Triggered Widget : Show Triggered widget list according to the selected variable.

• New Variable Name : Add a new variable name.

• Value Count : Set Default & Maximum value to the variable.

• Trigger Action : Set Trigger Action to the selected widget.
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14.3 Receiver

Add Receiver Event to the selected widget. When Equation returns True, Receiver Event will be shown.

• Variable Name : Show the list of variables that have Receiver Event.

• Receiver Widget : Show the list of Receiver Widget according to the selected variable.
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• Equation : Set Equation case. (e.g. Sample Variable = 1)

• Scroll Location : Set Equation range of the scroll position.

• Animation Effect : Set Animation Effect when Receiver Event is run.

• Duration : Set Duration for the Receiver Event.
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CHAPTER 15

Memo Panel

When you run Window > Memo (M) menu, Memo Panel will be shown. You can add a memo to the selected widget.
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• Show / Hide Table Toggle Button : Open or Close Memo List area.

• Title : Add title to the selected memo.

• Memo : Add memo to the selected widget.

Note: In the Memo List, you can modify Memo’s Number / Title / Content .
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CHAPTER 16

Manage Custom Widget Panel

When you run Window > Manage Custom Widgets (W) menu, Manage Custom Widgets Panel will be shown. You
can import Custom Widgets, Compositions and Pages into this panel. This panel supports Grid / Table view in Widget
list. You can open and close widget information area with toggle button next to the search box.
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16.1 Top Bar

• Widget Tab : Manage imported custom widgets. Import custom widget with import button.

• Page Tab : Manage imported custom page. Import custom page with import button.

• Composition Tab : Manage imported custom composition. Import custom composition with import but-
ton.

• Widget Information Toggle Button : Show or hide Custom Widget Information area.

• Search Bar : Search by custom widget name.

16.2 Widget Group List

Widget Group List is placed at the left side of the panel. You can browse Custom Widget List by selecting the group
name.

16.3 Custom Widget List

Custom Widget List is placed at the center of the panel.

• Import : Import custom widget file. (iuw)

• Refresh : Refresh current widget list.

• Open Folder : Open custom widget folder.

16.4 Custom Widget Information

Custom Widget Info is placed at the right side of the panel.

• Preview : Show the preview of the selected custom widget.

• Zoom In / Out : Zoom In or Out on the preview.

• Name : Display the name of the selected custom widget.

• Group : Display the group of the selected custom widget.

• Tag : Display the list of tags added to custom widgets.

• Description : Display the description of the selected custom widget.
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CHAPTER 17

Export Widget Panel

You can open Export Widget Panel from the left side of the canvas:

• Right-click the widget in structure section

• Right-click the page in pages

• Right-click composition in compositions
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• Customize Viewport Size : Resize viewport size of the custom widget.

• Name : Set name of custom widget.

• New Group : Set the group of the custom widget.

• Export Directory : Set the export directory of the custom widget.

• Description : Add descriptions to the custom widget.

17.1 Export Widget (.iuw)

When you export Widget , IUEditor generates CustomWidgetName.iuw file.

17.2 Export Page (.iup)

When you export Page , IUEditor generates CustomPageName.iup file.
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17.3 Export Composition (.iuc)

When you export Composition , IUEditor generates CustomCompositionName.iuc file.
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CHAPTER 18

Project Type

18.1 Default Project

Default Project is a Static Project which is not connected with any back-end framework. You can select Default Project
in New Project Popup (which pops up when you run File > New Project (N) menu)
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• Empty Page (Header / Footer) : Create new project with Empty Page (Header / Page Content /
Footer)

• Empty Page (Header) : Create new project with Empty Page (Header / Footer)

• Empty Page (Blank) : Create new project with Empty Page (Page Content)

• IUPro : Create new project with IUPro Template.

• Paper : Create new project with IUPaper Template.

• IUAcademy : Create new project with IUAcademy Template.

• Recent Project : Show last 5 projects that recently have been updated.

• Open Project : Open existing IU project.

Note: When you select Empty Page, you can set default width value of new project.

18.2 Django Project

Django Project is a Dynamic Project which can be connected with Django as back-end framework. You can select
Django Project in New Project Popup (which pops up when you run File > New Project (N) menu)
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18.3 AngularJS Project

AngularJS Project is a Dynamic Project which can be connected with AngularJS as back-end framework. You can
select AngularJS Project in New Project Popup (which pops up when you run File > New Project (N) menu)
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CHAPTER 19

Page

19.1 Page Setting

When you select the index page and click the Property button, Page Setting properties will be shown.
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• Empty Layout : Set Empty (Page Content) Page Layout .

• Header + Footer : Set Header + Page Content + Footer Page Layout .

• Header : Set Header + Page Content Page Layout

• Footer : Set Footer + Page Content Page Layout

• Page Title : Add Page Title to current page.

• Page Keyword : Add Page Keywords to current page. (Multiple keywords available)

• Page Description : Add Page Description to current page.

• Page Meta Image : Add Meta Image to current page. (URL)
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19.2 Page Custom Code

• Page Header Custom Code : Add Custom Code in header of current page.

• Page Header Custom Code for Backend : Add Custom Code for Backend in header of current page.

19.3 Page Default Widget

19.3.1 Page

IUPage is same as html document. You can change page structure in property tab.

19.3.2 Header
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Header is placed top of page. Header can import Header or another composition .

19.3.3 Page Content

Page Content is placed middle of page (Page Content cannot be removed). You can add sections in Page Content.

19.3.4 Footer

Footer is placed bottom of page. Footer can import Footer of another composition .

19.3.5 Section

Section is placed under Page Content.

19.3.6 Centered Box

Centered Box is placed under Section (Centered Box can be removed). Centered Box used for horizontal-center layout.

19.3.7 Panel
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You can add a panel by press [+] button of panel group. To call panel, create link with any widget and select link target
to panel.

19.3.8 Popup

You can add a popup by press [+] button of popup group. To call popup, create link with any widget and select link
target to popup.
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CHAPTER 20

Composition

You can create repeatable elements by using Compositions. Compositions will be imported to Import / Header /
Footer / Collection widgets.
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CHAPTER 21

Basic Widget

21.1 Box

Box widget is a basic widget which is generated to <div> tag. Mostly, Box widget is used to set layout and to group
children widgets.

Property

• Child : Valid

• Link : Valid

• Scroll Animator : Valid

• Background Image : Valid

• Backend Ellipsis : Invalid

21.2 Text
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Text widget contains Text Content which is generated to <p>, <h1> or <h2> tag. You can edit text after double-click
to widget.

Property

• Child : Invalid

• Link : Valid

• Scroll Animator : Valid

• Background Image : Valid

• Backend Ellipsis : Valid

21.3 Image

Static Image widget contains Image Content which is generated to <img> tag. You can input image resource from
Resource panel or Image URL link.

• Fit Widget Size to Image Size : Resize widget according to image resource size.

Property

• Child : Invalid

• Link : Valid

• Scroll Animator : Valid

• Background Image : Valid

• Backend Ellipsis : Valid

21.4 Static Image
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Image widget contains Image Content which is generated by css {background} tag. You can input image resource
from Resource panel or Image URL link and resize or rearrange image in widget area.

• Fit Widget Size to Image Size : Resize widget according to image resource size.

Property

• Child : Invalid

• Link : Valid

• Scroll Animator : Valid

• Background Image : Invalid

• Backend Ellipsis : Invalid

21.5 Cell

Cell widget contains Text Content , aligned Vertical-Center automatically. (PX unit only)

Property

• Child : Invalid

• Link : Valid

• Scroll Animator : Valid

• Background Image : Valid

• Backend Ellipsis : Valid

21.6 Image and Text

Image and text widget contains Text Content and Image, aligned Vertical-Center automatically.

Property

• Child : Invalid

• Link : Valid
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• Scroll Animator : Valid

• Background Image : Valid

• Backend Ellipsis : Valid
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CHAPTER 22

Complex Widget

22.1 Transition

Transition widget has two transition items. When mouse action triggered, transition item will change from item 1 to
item 2. You can set Mouse Action (Mouse Over or Click) , Transition Effect, and Duration in property panel.

Property

• Child : Invalid

• Link : Valid

• Scroll Animator : Valid

• Background Image : Invalid

• Backend Ellipsis : Invalid

22.2 Carousel
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Carousel widget has multiple carousel items. You can simply make carousel interface with carousel widget. Carousel
item is the same as Box widget, so you can add or remove child elements to Carousel item.

Property

• Child : Invalid

• Link : Valid(Only for child widget)

• Scroll Animator : Invalid

• Background Image : Invalid

• Backend Ellipsis : Invalid

22.3 Google Map

Google Map widget represents google map element. You can input Map location wherever you want.

Note:

1) In Editor Mode, Google Map widget offers maximum preview 600 px x 600 px size.

2) South Korea’s map is not available Color Theme feature.

Property

• Child : Invalid

• Link : Invalid

• Scroll Animator : Valid

• Background Image : Invalid

• Backend Ellipsis : Invalid

22.4 Web Movie
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Web Movie widget supports Youtube or Vimeo. You can use Web Movie widget with Short-Links :

• Vimeo : http://vimeo.com/ videoURL

• Youtube : http://youtu.be/ videoURL

Property

• Child : Invalid

• Link : Invalid

• Scroll Animator : Valid

• Background Image : Valid

• Backend Ellipsis : Invalid

22.5 Video Clip

Video Clip widget supports MP4. You can input videos from Resource panel.

Property

• Child : Invalid

• Link : Valid

• Scroll Animator : Valid

• Background Image : Valid

• Backend Ellipsis : Invalid

22.6 Table

Table widget can add simple table on canvas.
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Property

• Child : -

• Link : -

• Scroll Animator : -

• Background Image : -

• Backend Ellipsis : -

22.7 Simple Tab View

Simple Tab View widget has more simple structure than Tab View widget .

Property

• Child : -

• Link : -

• Scroll Animator : -

• Background Image : -

• Backend Ellipsis : -

22.8 Tab View

Tab View widget has multiple Tabs .

Property

• Child : -

• Link : -

• Scroll Animator : -
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• Background Image : -

• Backend Ellipsis : -

22.9 Collapsible

Collapsible widget has two item (Header and Content). When you triggered mouse action on Collapsible widget,
Content item will be appeared. You can set Mouse Action (Mouse Over or Click) , Transition Effect, and Duration
in property panel.

Property

• Child : -

• Link : -

• Scroll Animator : -

• Background Image : -

• Backend Ellipsis : -

22.10 Import

Import widget can import Composition . If you want to use Composition, connect target Composition into Import
widget.

Property

• Child : Invalid

• Link : Valid

• Scroll Animator : Valid

• Background Image : Valid

• Backend Ellipsis : Invalid
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22.11 Tweet Share Button

With Tweet Share Button widget, you can add Share to Tweeter Button in your project. (No Resize)

Property

• Child : Invalid

• Link : Valid

• Scroll Animator : Valid

• Background Image : Valid

• Backend Ellipsis : Invalid

22.12 Facebook Like Button

With Facebook Like Button widget, you can add Share to Facebook Button in your project. (No Resize)

Property

• Child : Invalid

• Link : Valid

• Scroll Animator : Valid

• Background Image : Valid

• Backend Ellipsis : Invalid

22.13 Centered Box
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Centered Box widget makes horizontal centered layout to Section. Centered Box widget is added into section auto-
matically, but you can remove this widget. (No resize)

Property

• Child : Invalid

• Link : Valid

• Scroll Animator : Valid

• Background Image : Valid

• Backend Ellipsis : Invalid

22.14 Progress Bar

Progress Bar widget displays a progress bar. If you want draw certain status with bar elements, add this widget in your
project.

Property

• Child : Invalid

• Link : Valid

• Scroll Animator : Valid

• Background Image : Invalid

• Backend Ellipsis : Invalid

22.15 SVG (Scalable Vector Graphics)

SVG widget displays Scalable Vector Graphics. You can select simple SVG form, or input custom <svg> code
whatever you want.
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Property

• Child : Invalid

• Link : Valid

• Scroll Animator : Valid

• Background Image : Invalid

• Backend Ellipsis : Invalid
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CHAPTER 23

Programming Widget

23.1 Form

Form widget is a container for programming widgets which is generated to <form> tag. If you want to use program-
ming widgets, you must to add Form widget in your project.

Property

• Child : Valid

• Link : Invalid

• Scroll Animator : Valid

• Background Image : Valid

• Backend Ellipsis : Invalid

23.2 Input Text
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Input Text widget is a textfield which is generated to <input> tag (type : text).

Property

• Child : Invalid

• Link : Valid

• Scroll Animator : Valid

• Background Image : Valid

• Backend Ellipsis : Invalid

23.3 Input Paragraph Text

Input Paragraph Text widget is a textfield which is generated to <textarea> tag.

Property

• Child : Invalid

• Link : Valid

• Scroll Animator : Valid

• Background Image : Valid

• Backend Ellipsis : Invalid

23.4 Select

Select widget is a select button which is generated to <select> tag. If you want to make select button, add this widget
into Form widget.

Property
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• Child : Invalid

• Link : Valid

• Scroll Animator : Valid

• Background Image : Valid

• Backend Ellipsis : Invalid

23.5 HTML (Hyper Text Markup Language)

HTML widget is a code container which is generated to custom html tag (e.g. <style>, <script>, etc, . . . ). You
can make custom widget by input custom html code into HTML widget.

Property

• Child : Invalid

• Link : Invalid

• Scroll Animator : Valid

• Background Image : Valid

• Backend Ellipsis : Invalid

23.6 Collection

Collection widget can import multiple Composition widgets. If you want to make collection view with compositions,
you can create collection view with Collection widget.

Property

• Child : Invalid

• Link : Valid

• Scroll Animator : Valid

• Background Image : Valid
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• Backend Ellipsis : Invalid

23.7 Page Number Set

Page Number Set widget displays page links that usually placed bottom of Collection.

Property

• Child : Invalid

• Link : Valid

• Scroll Animator : Valid

• Background Image : Valid

• Backend Ellipsis : Invalid

23.8 Checkbox

Checkbox widget displays checkbox which is generated to <input> tag (type:checkbox).

Property

• Child : Invalid

• Link : Valid

• Scroll Animator : Valid

• Background Image : Invalid

• Backend Ellipsis : Invalid

23.9 Radio Button
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Radio Button widget displays radio button which is generated to <input> tag (type:radio).

Property

• Child : Invalid

• Link : Valid

• Scroll Animator : Valid

• Background Image : Invalid

• Backend Ellipsis : Invalid

23.10 Button

Button widget displays button which is generated to <input> tag (type:default / reset / submit).

Property

• Child : Invalid

• Link : Invalid

• Scroll Animator : Valid

• Background Image : Valid

• Backend Ellipsis : Invalid

23.11 File Upload

File Upload widget displays file upload interface which is generated <input> tag (type:file).

Property

• Child : Invalid
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• Link : Invalid

• Scroll Animator : Valid

• Background Image : Invalid

• Backend Ellipsis : Invalid

23.12 Switch

Switch widget displays toggle button which is generated to <input> tag (type:checkbox), and contains two switch
items.

Property

• Child : Invalid

• Link : Invalid

• Scroll Animator : Valid

• Background Image : Invalid

• Backend Ellipsis : Invalid

23.13 Flip Switch

Flip Switch widget displays sliding switch which is generated to <input> tag (type:checkbox).

Property

• Child : Invalid

• Link : Invalid

• Scroll Animator : Valid

• Background Image : Invalid

• Backend Ellipsis : Invalid
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23.14 Slider

Slider widget displays slider interface. You can change value by dragging slide pointer. (Or type a number to value)

Property

• Child : Invalid

• Link : Invalid

• Scroll Animator : Valid

• Background Image : Invalid

• Backend Ellipsis : Invalid

23.15 Range Slider

Range Slider widget displays range slider interface. You can change range value by dragging slide pointers. (Or type
a number to value)

Property

• Child : Invalid

• Link : Invalid

• Scroll Animator : Valid

• Background Image : Invalid

• Backend Ellipsis : Invalid
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CHAPTER 24

Known Bug List

Here are bug list for current version.

24.1 Scroll Animator (Event Panel)

Scroll Animator is only available for Absolute Position widgets , Sometimes available for Relative Position widgets.

24.2 Unsupported variable name (Event Panel)

Variable name cannot have special characters and numbers, but only can Underbar(_).

24.3 ‘#’ or ‘@’ character in File Path

If file path has ‘#’ or ‘@’ character, IUEditor cannot load resource path. Do not use ‘#’ or ‘@’ character in file path.
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CHAPTER 25

Preference

Set IUEditor’s service environment.
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25.1 General

• Select Tab Menu : Show or hide tab menus from top toolbar.

• Guide Line Color : Change guide line color. (View guideline : View > Guide ;)

• Custom Template List URL : Input plist URL for apply custom template at new project window’s tem-
plate list.
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25.2 Project

• Project Save Option : Compress project’s json file if ‘Minimize Data’ checkbox checked.

• Compile Option

– Export HTML ID Option : Select whether contain HTML ID as default to all widget or cus-
tomize.

– Name on Structure : Select whether contain widget’s name in html document or not.

• Resource Copy Option : Select how to do about multiple resources when Custom Widget added on can-
vas.

• Widget Option : Select to contain centerbox in section as default .

25.3 Fonts

Add new webfont into font list.
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CHAPTER 26

Templates

IUEditor offers free templates projects below. You can select template project in New Project panel.

• IUPro .. image:: resource/templates/iupro.png

• IUPaper .. image:: resource/templates/paper.png

• IUAcademy .. image:: resource/templates/academy.png
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CHAPTER 27

Shortcut

27.1 Project Management

• Project Setting Shift+Cmd+P : Open Project Setting panel.

• Refresh Shift+Cmd+F : Refresh current page.

• Import Custom Widget Shift+Cmd+W : Open Custom Widget Panel.

27.2 Mode Switch

• Editor Mode Cmd+[ : Switch to Editor Mode.

• Developer Mode Cmd+] : Switch to Developer Mode.

• Prototype Mode Cmd+\ : Switch to Prototype Mode.

27.3 Add Widget

• IUBox Cmd+1 : Select IUBox widget to add on canvas.

• IUText Cmd+2 : Select IUText widget to add on canvas.

• IUImage Cmd+3 : Select IUImage widget to add on canvas.

• IUStatic Image Cmd+4 : Select IUStatic Image widget to add on canvas.

• IUCell Cmd+5 : Select IUCell widget to add on canvas.
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27.4 Widget Control

• Copy Cmd+C : Copy selected widget.

• Paste Cmd+V : Paste copied widget.

• Undo Cmd+Z : Undo steps.

• Duplicate Cmd+D : Duplicate selected widget.

• Redo Shift+Cmd+Z : Redo steps.

27.5 View Management

• Zoom In Cmd+ + : Zoom In stage.

• Zoom Out Cmd+ - : Zoom Out stage.

• Widget Panel Cmd+Return : Show and Hide Widget panel.

• Event Panel Shift+Cmd+E : Open Event panel.

• Resource Panel Shift+Cmd+R : Open Resource panel.

• Memo Shift+Cmd+M : Open Memo panel.

27.6 Canvas View Management

• Show Outline Cmd+L : Show or hide outline of widgets in canvas.

• Show Widget Info Cmd+I : Show or hide information of widgets in canvas.

• Show Ruler Cmd+R : Show or hide ruler on canvas.

• Show Guide Cmd+; : Show or hide guide on canvas.

• Tracing Shift+Cmd+T : Show or hide tracing image on canvas.
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CHAPTER 28

Dictionary

Definitions of words which used in this documents.

28.1 Build

Generate HTML & CSS & JS files based on IU Project.

28.2 Django

Python web framework.

28.3 Python

Server-side programming language.

28.4 Widget

Basic elements to create IU Project.
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CHAPTER 29

Tutorials

Here are basic tutorials for IUEditor.

Go Tutorial

• Tutorial 101 - Blog-Style Web page

• Tutorial 201 - Responsive Magazine View Part1 - Design

• Tutorial 202 - Responsive Magazine View Part2 - Media Query
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